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Waters GPC 

Please see Pete for training before your first use.  

General 
● Check THF reservoir. THF is consumed at 0.35 mL/min when running samples,            

and there should never be less than 2” of solvent at the bottom of the bottle.                
See ​Advanced user topics​ for refilling THF. 

 
● Check that waste bottle (under sink) can accommodate the expected amount           

of waste.  THF waste in commonly repurposed, so ask Pete before disposal. 
 

● The instrument is controlled using ​Breeze software, which organizes large data           
sets into ​projects​. The active ​project is displayed above the file menu            
(except when data is being viewed). All samples should be run on the most              
recent ​project​, named Jan + current year. See ​Advanced user topics to change             
projects​.  

 
● The ​Navigation toolbar on the left-hand side of the screen allows you to toggle              

between functions.  ​Find Data​ and ​Sample Queue​ buttons are most useful. 
 

Sample preparation 
1. Completely dissolve sample (water and salt-free) at ~ 0.5 mg/mL in ​Sample            

Prep THF [1:1000 toluene:THF] located next to THF reservoir. Heating may be            
necessary. 

2. Cool to room temp and filter sample through 0.2 μm PTFE filter using a 1 mL                
syringe into GPC vial and cap. Label vial with page/exp # using permanent             
marker for future ID.  See ​Advanced user topics​ for ​Low-solubility polymers​. 

 

Run a new Sample Set 
Regular users should ​Create​ ​method template​ as described in ​Advanced user topics 
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1. Open Breeze and change flow rate from 0.10 mL/min to ​0.35 mL/min​. Allow             
pressure to stabilize at 350 – 600 for > 3 min (20 min is preferable).              

 
2. Open door on Autosampler and wait for the motor noise to subside. Load             

vial(s) into sample holder, record their position, and close door. 
3. Click ​Sample Queue​ button on Navigation toolbar.  
4. Click “File → New Sample Set → New” to clear previous sample set. 

a. Alternatively, previous sample sets can be modified by substituting in          
your info in ​Vial, Sample Name, and ​Inj Vol ​columns. Ensure that            
modified sample set follows protocol outline in steps 2-8, then proceed           
to step 9. 

5. Click in the ​Function​ column in the empty table.  A new row will appear.  
6. Click on the drop-down menu to change the ​Function to ​Condition Column​.            

Under the ​Method column, select the method with the most recent date (e.g.,             
06_10_15_NBore_PS_Tol​). 

7. Set run time to 10 min. If flow rate has been at 0.35 mL/min for 20 minutes or                  
more, the run time can be reduced to as short as 1 min. 

8. To add samples, click in the empty part of the table to add a new row. Change                 
Function ​to ​Inject Broad Samples​. Change ​Vial and ​Sample Name as desired,            
and use the same ​Method as your Condition Column. Run time should be 35.00              
min. 

9. Inj Vol can be changed from 5.0-50.0 (µL) depending on sample concentration.            
Samples that are too concentrated can harm the instrument (injector, columns)           
and saturate the detector (bad data!). See ​Advanced user topics for           
Low-solubility polymers​. 

10.Add additional samples using steps 8 and 9. Adding, inserting, and deleting            
rows can also be achieved through right-clicking on desired cells. 

11. ​The final row should always be a ​Condition Column using the            
Shutdown_NBore​ method.  Set ​Run Time​ to 0.15 min. 

a. All sample sets should follow same format, and with 2 samples should            
appear as: 
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12.Click on the start button, located on the left side of gray ​Acquisition toolbar              
(on bottom).  

 
13.A pop-up menu appears that demands that you enter a sample set name.             

Settings for this sample set​ should be set to ​Run Only​.  Click run. 
a. The sample set moves to the ​Running tab (bottom left side of the table),              

and the rows that are running or have run are shown in red. 

 
b. Data is plotted in real time on the right side of the ​Acquisition toolbar​. 

 

 

Adding samples when GPC is already running 
Step 13 from ​Run a new ​Sample Set can be used to determine whether a sample set is                  
running. 

1. “Right click on the sample set table → ​Alter Running Samples​”. A pop-up             
warning will appear; click OK. ​Note that no further samples will be run until              
step 3 is completed. 

2. Use steps 2, 3, 8-10 from ​Run a new ​Sample Set to add samples ​before               
Shutdown method 

3. Follow step 12 from ​Run a new ​Sample Set​ to resume acquisition. 
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Process and view results 
Processing automatically picks peaks, applies baseline correction, and adjusts         
retention time to the toluene reference peak at ~32.1 min. Without toluene            
reference, mw data can’t be calculated. 

1. Click the ​Find Data button from Navigation toolbar to switch over to a list of               
previously run samples. The settings listed at the top of the page filter what              
files are observed. 

 
2. The most useful tabs are ​Channels​ and ​Results​.  Click on C​hannels​. 
3. The ​Filter By: menu allows you to restrict observable files by several time             

metrics; select the most appropriate one. Click ​Update to apply the filter AND             
to add recently acquired samples to the table. 

a. Each sample is listed as three separate files according to the method of             
detection. Only ​Channel​s “2487Channel 1” (absorbance at 254 nm) and          
410 (refractive index (RI) detector) can be used to calculate molecular           
weight information (i.e. they calibrated to polystyrene standards and a          
toluene reference). 

 
b. To view data without processing, follow “right click on desired file →            

Review​”.  
4. Process data (for mw info) by selecting the desired channel (or “ctrl + left-click              

on multiple channels”) then “right-clicking a channel → ​Process​”. 
5. A pop-up menu will be displayed. 

a. Select​ Process as acquired​ and click OK.  Do this 99% of the time. 
b. If your sample was run on the wrong method or the calibration curve was              

recently updated, you can process your data using a different calibration           
curve. Select ​Use specified method and choose the desired method          
from the drop-down menu. 
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6. Processed samples can be viewed by going to the ​Results tab (adjust Filter and              

click ​Update until they appear). “Right click your file → ​Review​”. Alerts may             
appear asking: 
“…Do you want to replace all your existing data?” – Answer ​Yes  
“…Do you wish to save them before switching?” – Answer ​Yes  

a. M​n and dispersity are displayed for only one peak. Peaks may be added             
or modified by left-clicking on the plotted line and dragging across the            
desired time range. Peaks can be removed by “right click → delete”            
from the table.  

 
b. The plot can be resized by clicking “​View​” from the file menu and             

selecting one of the following options: 
i. Full View – scales the x-axis to the entire run time. 
ii. Scale to Peak – scales the y-axis to the integrated peak. 

iii. Autoscale – scales axes to max peak height and entire run time. 
c. Manual zoom can also be applied by left-clicking and dragging across a            

region. 
d. To view groups of samples, “Ctrl + click on desired samples → ​Review​” 

 



 
 
McNeil Group                    University of Michigan 

i. Click the ​Overlay button (above the plot) to view multiple          
chromatograms 

                    
ii. To change which chromatograms are displayed, click the ​Channels         

tab (below the table) and check/uncheck the ​Visible​ column. 
iii. Overlay view remains on for subsequent plots until button is          

clicked again. 
 

Report (processed data) 
After data has been processed (see ​Process and review results​), chromatogram and            
associated mw data may be saved or printed as a ​Report. 

1. From ​Results tab under ​Find Data button, “right click on desired sample →             
Preview​.” 

2. Select ​Use a Report Method…appropriate for the selected data​ and click OK. 
3. Choose to Save or Print report from the toolbar on top. Note that only the first                

page(s) contain the most useful information. 
 

Export (raw data) 
Export time and absorbance data (from each channel) to plot chromatograms in Sigma             
Plot or Excel (see ​Process exported data in ​Advanced user topics​). Regular users             
should make your own export method following procedures under ​Create export           
method​ in ​Advanced user topics 

1. From ​Channels or ​Results tab, “right click       
→ ​Export​”.  Opens menu 

2. Ensure that ​Export box is checked, and       
Export to desktop is the ​specified export       
method. 

3. File will appear on the desktop as “​Export        
to Desktop​” + a random series of numbers.        
Sample name and several acquisition     
parameters are listed within the     
spreadsheet. 

4. Extract the data that you need (or copy the         
file to a flash drive) then delete the file         
from the desktop. Files like these clutter       
the desktop and may be deleted      
periodically. 
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Advanced user topics 
 

Acquisition 
THF refill 

If only a small amount of additional THF is needed, it may be added to the current                 
reservoir. Otherwise, THF should be replaced with a completely new bottle of            
stabilized THF using the following instructions.  

1. Adjust flow rate to 0.00 mL/min through Breeze software. 
2. After flow stops, replace empty bottle with full one. Make sure that metal             

filters are still attached to the green and thick white lines AND that the lines               
are completely submerged. 

3. Adjust flow rate to 0.10 mL/min through Breeze software. 

 

Create a method template 

1. From ​Sample Queue in Navigation toolbar, go “Edit → Open Sample Set Method             
Template” 

2. Open template named ​Template​. Click through the wizard, making sure to           
check ​Inject Samples and set parameters for a typical run. Near the end, you              
can define which parameters will change from run to run. 

3. Save template under a different name. 

 

Low- solubility polymers 

Polymers with a low solubility in THF should be prepared as dilute solution with a high                
injection volume (~ 50 µL). If aggregation or precipitation of the polymer occurs at              
these concentrations, the sample can be prepared immediately prior to injection. In            
this case, the polymer can be passed through the 0.20 μm PTFE filter while the THF is                 
still hot, and injected before it cools.  

 

View Acquisition toolbar 

The ​Acquisition ​toolbar (on the bottom of the screen) displays the run controls,             
flow-rate, pressure, and data from the detectors. There is a check-box (located            
below the Navigation toolbar) to view the ​Acquisition toolbar. Always make sure that             
the ​Acquisition​ toolbar is visible when you leave the computer. 

 

Process exported data 

Normalize​ to compare chromatograms as overlaid or stacked plots. 
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1. Open ​Normalize or ​Normalize with graph excel file from ​Documents folder. Do            
not save any modifications to these files. 

2. Copy all absorbance values from exported data, and paste into columns B-G            
under ​Enter data here!Normalized to 1​ tab. 

3. Data is normalized to 1 a.u. and is simultaneously formatted in three different             
ways: 

a. The ​Enter data here!Normalized to 1 tab directly overlays         
chromatograms. 

b. The Normalized short stacked A top tab formats data with 0.5 a.u.             
spacing between curves, which is useful for plotting multiple similar          
chromatograms. 

c. The ​Normalized stacked A on top​ tab formats data with 1 a.u. spacing. 

4. Paste normalized values into Sigma Plot or use plots generated in ​Normalize            
with graph​. 

 

Create an export template 

1. From ​Find Data in Navigation toolbar, select a file then “​Database → ​Export             
Data​” from the file toolbar. 

2. Select Template as export method and click Edit Method to open Export            
Method Editor. 

a. Editor opens under the ​Fields tab, which exports experimental         
parameters and processed values as a text file. If this information is            
desired, change file name/ location and report parameters 

b. Raw Data should always be included in your export method. Change file            
name/location and modify desired parameters. 

3. “File → Save As” to alter the name. 

 

Change Projects (find old data) 

Breeze software organizes large data sets into ​Projects​. The active ​project is            
displayed above the file menu (except when data is being viewed). All samples should              
be run on the most recent ​project​, named Jan + current year. Only the files (data,                
methods, calibration curves) created within the active ​project can be accessed. To            
find old files from a different ​project​:  

1. Click on ​Manage Breeze​ on the Navigation toolbar → ​Projects​.  

2. The ​Comments column describes the time range over which data was collected.            
“Right click on the desired project → ​Switch To…​” and select desired ​project​.             
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This can be performed while samples are still running in the most recent             
project. 

3. After the old data is viewed/extracted, switch back to the most recent            
project. 

 

Alter sample information 

Sample Name and ​Sample Type can be edited post-run, so data can be retrieved even               
if you used the wrong name or ran your samples as ​narrow standards​.  

1. Click on ​Find Data​ in the Navigation Toolbar. 

2. Select the ​Injections​ tab and find your sample(s).  

3. “Right click → Alter Sample”, then change ​Sample Name and ​Sample Type as             
appropriate. All other items are related to the run conditions, and cannot be             
modified. 

 


